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1. Безопасность и уход 

1. Пожалуйста, внимательно прочитайте это руководство пользователя перед 
использованием устройства. Несоблюдение инструкций по эксплуатации, перечисленных в этом 
руководстве, может привести к необратимому повреждению устройства. 

2. Этот продукт содержит крошечные части и компоненты, которые не являются съедобными. 
Дети и подростки могут пользоваться устройством только под руководством и контролем взрослых. 
Инвалиды, пациенты и люди с аллергией не должны пользоваться этим устройством. 

3. Мы не рекомендуем использовать это устройство на открытом воздухе. Оно не является 
водонепроницаемым, и его нельзя помещать в экстремальные условия: тепло, высокое давление и т. 
д. Пожалуйста, храните и используйте его в безопасном, чистом и сухом месте. Держите его подальше 
от масла, газа, воды и агрессивных веществ. Метод хранения относится к другим электронным 
продуктам, таким как компьютер. 

4. Очистите объектив, когда изображение становится размытым: сначала отключите питание, 
протрите объектив мягкой чистой тканью, смоченной спиртом, перед повторным включением 
убедитесь, что все устройство высохло. Эти действия следует выполнять и при ежедневной очистке, 
не забывая протирать ТОЛЬКО ИЗОЛИРОВАННУЮ часть монитора. 

5. Экран монитора очень хрупкий, используйте его осторожно. Не роняйте, не нажимайте 
сильно и не оставляйте его с острыми предметами. Удерживая рамку монитора, отрегулируйте его 
ориентацию. Монитор не является водонепроницаемым, протирайте его мягким и сухим материалом. 

6. Имейте в виду, что этот микроскоп не предназначен для медицинского использования. 

2. Кнопки и подключение 

1 Включение / выключение питания 8 Фокусирующая трубка 

2 Режим/Меню 9 Винты крепления объектива 

3 Вверх/Цифровое увеличение 10 Сброс 

4 Вниз/Цифровое уменьшение 11 HDMI порт 

5 ОК/Начать запись 12 USB-порт 

6 Съемка изображения (во время записи) 13 Слот для карт памяти SD 

7 Приемник дистанционного сигнала (куда вы 
направляете пульт ДУ) 

  



4 
 

Andonstar Руководство по эксплуатации 

3. Установка кронштейна 

1 Подъем вторичного кронштейна 6 Зажимы 

2 Стойка для штанги 7 V-фиксатор стойки (фиксация стойки в 
вертикальном направлении) 

3 Ограничитель нижнего предела 8 H-образный фиксатор стойки (фиксирует 
стойку в горизонтальном направлении) 

4 Винты крепления монитора 9 Разъем питания для точечных 
светильников 

5 Точечные светильники   

3.1 Сборка моделей Plus 
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4. Быстрый старт 
1. Для включения микроскопа подключите прибор к источнику питания (5 В, 2 А и выше), как 

показано на рисунке. 
2. Нажмите и удерживайте кнопку питания (①), пока не загорится монитор. (устройство может 

автоматически включаться при включении питания, это абсолютно нормально)  
* Устранение неполадок 
Когда изображение на мониторе останавливается или зависает, воспользуйтесь отверстием 

сброса (⑩), чтобы перезагрузить устройство, а затем включите устройство снова. (Отверстие сброса 
очень маленькое, расположено на задней панели монитора. Возможно, вам придется 
воспользоваться помощью других инструментов в этом процессе. После этого все настройки 
микроскопа вернутся к заводским, но при этом не будут удалены файлы, сохраненные на карте 
памяти). 
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5. Как выбрать объектив 

 

Диапазон фокусировки：90 – 300 мм, увеличение：60-240x (с 3-кратным 
цифровым зумом, вывод на 28-дюймовый монитор HDMI) 
Применение: наблюдение за печатными платами, ремонт часов и т. д. 
 
 
 
 
 
 
 

Линза L 

USB порт 

Разъем питания для светильников 

USB 

Подключение 

Увеличение яркости 

Уменьшение яркости Вкл./выкл. 
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Микроскоп с линзой L 

Шаги：На рисунке отмечено, какие части микроскопа участвуют в каждом шаге. 
① Установите и закрепите линзу L в нижней части фокусировочной трубки. 
② Согните два точечных светильника с "гусиной шеей", чтобы поле зрения было достаточно 

освещенным. 
③Освободите V-образный фиксатор кронштейна, расположите всю часть монитора на 

желаемой высоте (расстояние от линзы до образца должно составлять примерно 90–300 мм), затем 
закрепите V-образный фиксатор. Чтобы более точно отрегулировать расстояние до объекта, 
отрегулируйте высоту вторичного кронштейна. Чем меньше расстояние до объекта, тем больше 
увеличение. 

④Поверните фокусировочную трубку, чтобы получить четкое изображение. Поверните ее по 
часовой стрелке для увеличения и в другую сторону для уменьшения. 

 
 

Диапазон фокусировки：12 – 320 мм, увеличение：18-720x (с 3-
кратным цифровым зумом, вывод на 28-дюймовый монитор HDMI) 

Применение: Наблюдайте за монетами целиком или по частям, 
собирайте камни/марки, наблюдайте за печатными платами и т.д. 

 
 

 
 
 
 
 
 
 

Линза A 
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Микроскоп с линзой A 

Шаги：На рисунке отмечено, какие части микроскопа участвуют в каждом шаге. 
① Установите и закрепите линзу A в нижней части фокусировочной трубки. 
②Согните два точечных светильника на «гусиной шее» и убедитесь, что свет попадает на 

монету. 
③Освободите V-образный фиксатор кронштейна, расположите всю часть монитора на 

желаемой высоте (расстояние от линзы до образца должно составлять от 12 до 320 мм), затем 
закрепите V-образный фиксатор. Чтобы более точно отрегулировать расстояние до объекта, 
отрегулируйте высоту вторичного кронштейна. Чем меньше расстояние до объекта, тем больше 
увеличение. 

④Поверните фокусировочную трубку, чтобы получить четкое изображение. Поверните ее по 
часовой стрелке для увеличения и в другую сторону для уменьшения. 

 
*Для наблюдения за частью монеты, пожалуйста, опустите рычаг, чтобы уменьшить расстояние 

до объекта, затем поверните фокусировочную трубку, чтобы получить четкое изображение. 
*Приведенные выше шаги можно также применять для наблюдения за растениями, камнями и 

т.д. 
 
 

Диапазон фокусировки：4 – 5 мм, увеличение：1800-2040x (с 3-кратным 
цифровым зумом, вывод на 28-дюймовый монитор HDMI) 
Применение: Слайды для микроскопа и т.д. 
 

Линза D 
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Микроскоп с линзой D 
Шаги: На рис. отмечено, какие части микроскопа задействованы на каждом этапе. 
① Установите и закрепите линзу D в нижней части фокусировочной трубки. 
②Поместите слайд в держатель слайдов и включите держатель слайдов (в этом случае 

точечные светильники «гусиная шея» не могут обеспечить надлежащего освещения, поэтому оставьте 
их и используйте тот же кабельный интерфейс для питания держателя слайдов) 

③Освободите V-образный фиксатор кронштейна, расположите всю часть монитора на 
желаемой высоте (расстояние от линзы до образца должно составлять примерно 4–5 мм), затем 
закрепите V-образный фиксатор. Поскольку в этом случае диапазон фокусировки очень мал, мы 
рекомендуем пользователям вместо этого отрегулировать высоту вторичного кронштейна, что 
является более точным. Чем меньше расстояние до объекта, тем больше увеличение. 

④Поверните фокусировочную трубку, чтобы получить четкое изображение. Поверните ее по 
часовой стрелке для увеличения и в другую сторону для уменьшения. 

*Увеличение объектива D довольно велико, что требует небольшого расстояния до объекта. 
При этом любое малейшее движение или встряхивание образца будет отображаться на мониторе как 
огромное, что требует от пользователя действовать очень осторожно и терпеливо. 

6. Цифровой зум 

Нажмите кнопку «вверх» на мониторе (③), чтобы применить цифровое увеличение, и кнопку 
«вниз», чтобы уменьшить масштаб (④). 

7. Сохранение файлов на карте памяти micro SD 

Чтобы сохранить изображения и видео на карту памяти, вставьте карту в слот TF на задней 
панели монитора перед включением устройства. 

Внимание: 
1. Карта памяти TD не входит в стандартную комплектацию. Пожалуйста, приобретайте их у 

качественных поставщиков. Мы рекомендуем высокоскоростные TF-карты 10-го класса. 
2. Сторона карты с металлической полосой обращена наружу. 
3. Вставьте карту в гнездо до щелчка. В противном случае она будет отскакивать назад. 
4. Если на мониторе отображается сообщение "ошибка карты" или "карта заполнена", 

отформатируйте карту перед съемкой. Форматирование выполняется следующим образом: Нажмите 
и удерживайте кнопку "M", пока не появится меню → нажмите кнопку "M" еще раз, чтобы войти в 
меню настроек → нажмите кнопку вверх или вниз для выбора → выберите пункт "Format" и 
подтвердите выбор. 



10 
 

Andonstar Руководство по эксплуатации 

5. Не вставляйте карту памяти во время работы микроскопа. В противном случае микроскоп 
автоматически выключится. И его придется включать снова. 

 
Для того чтобы снимать видео, фото или воспроизводить отснятые файлы, необходимо сначала 

выбрать режим. Кнопка MODE（②，обозначенная как "M"） может использоваться для выбора 

одного из трех режимов: видео( ), фото( ) и воспроизведения( ). 

8. Запись видео 

В режиме видео( ) и фото( ) нажмите кнопку "OK", чтобы начать запись. Для остановки 
нажмите ее еще раз. 

Аналогично, как и с кнопкой "OK" на пульте ДУ. 
В режиме видео в правом верхнем углу монитора отображается время и надпись "1080FHD" 

(белый шрифт). 
Время здесь показывает, сколько времени карта памяти способна записывать видео, а 

"1080FHD" - текущее разрешение видео. 

9. Фотосъемка 

В режиме видео( ), фото( ) и во время записи нажмите кнопку захвата( ), чтобы 
сделать фотографии. 

Кнопка, обозначенная на пульте как камера (⑥), работает аналогичным образом. 
* В режиме воспроизведения микроскоп не может снимать фото или видео. 

10. Воспроизведение и управление файлами 

Для перехода в режим воспроизведения используйте кнопку "M", для просмотра файлов 
нажимайте "вверх" или "вниз". 

Чтобы воспроизвести видео, нажмите “OK” для его воспроизведения, “OK” для паузы, “M” для 
остановки. 

* В режиме воспроизведения микроскоп не может снимать фото или видео. 
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11. Дистанционное управление 

1. Стоп-кадр: Сохранение изображения на экране. Работает в режимах режиме видео, фото и 
во время записи. 

2. Увеличение и уменьшение яркости: компенсация экспозиции от +2,0 до -2,0. 
3. Повышение и понижение резкости: существует три уровня резкости: мягкий / нормальный / 

сильный. Обе эти кнопки используются для переключения уровней, но в разном порядке. 
4. Увеличение и уменьшение контрастности: тот же принцип, что и с резкостью. 

5. Настройки линии пересечения (сетка): ‘十' на пульте дистанционного управления 
предназначен для настройки линии сетки. 

6. Повышение и понижение резкости: существует три уровня резкости: мягкий / нормальный / 
сильный. Обе эти кнопки используются для переключения уровней, но в разном порядке. 

7. Увеличение и уменьшение контрастности: тот же принцип, что и с резкостью. 
8. Поворот изображения: обратитесь к изображениям ниже 

Стоп-кадр 
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9. Ч/б изображение: обратитесь к изображениям ниже 
                 Обычный                                          Ч/б      

12. Настройки 

В любом режиме нажмите кнопку M и удерживайте ее некоторое время, пока на дисплее не 
появится меню Видео/Фотосъемки/Воспроизведения (или нажмите кнопку MENU на пульте ДУ). 
Снова нажмите кнопку M, чтобы войти в общее меню настроек. Например, если вы находитесь в 
режиме видео и нажимаете кнопку MENU, то на экране появится первое меню – «Меню видео» 
(слева). Затем снова нажмите кнопку MENU (или M на мониторе), и вы попадете в меню настроек, как 
показано справа: 
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13. Настройки линий сетки (требуется удаленное подключение) 

Используйте «Вверх» и «Вниз», чтобы выбрать между «Перекрестная линия», «Линия», 
«Направление», «Местоположение», «Цвет» и «Широта». Используйте кнопки «Влево» и «Вправо» 
(обозначены яркостью +&) для изменения настроек. Микроскоп не может справиться с этой 
настройкой, нужен пульт. Поперечная линия, как следует из названия, представляет собой пару 
вертикальных и горизонтальных линий, расположенных в самой середине 

 
Когда вы включаете функцию «Линия», автоматически отображаются 8 линий (названных от 1 

до 8). Для каждой из них вы можете изменить направление («HOR» или «VER», что означает 
«горизонтальный» и «вертикальный»), положение, цвет и ширину. Чтобы удалить ненужную строку 
из поле зрения, измените его цвет на «ПРОЗРАЧНЫЙ», см. следующий рисунок. 

 

14. Установка даты / времени 

Выберите «Дата/время» в меню настроек, нажмите кнопку «ОК», чтобы перейти к настройке 
времени. Используйте кнопки «вверх» и «вниз», чтобы выбрать правильный номер, OK, чтобы 
подтвердить и перейти к следующему. После того, как все будет сделано, нажмите M, чтобы вернуться 
в меню настроек. 

15. Сохранить настройки 

Чтобы микроскоп запомнил изменения настроек, выключите микроскоп, НАЖИМАЯ КНОПКУ 
ПИТАНИЯ НА МОНИТОРЕ (нажмите и удерживайте, пока он не выключится). Изменения настроек не 
сохранятся, если вы выключите устройство другими способами 

16. Вывод на внешние устройства 

16.1 HDMI 

 Во-первых, убедитесь, что внешнее устройство является реальным монитором HDMI 
FHD 1080P, в противном случае разрешение дисплея не может достигать 1080P. 

 Включите микроскоп и подключите его к монитору HDMI. Микроскоп не имеет 
встроенного аккумулятора, поэтому убедитесь, что микроскоп включен все время. 

 Включите микроскоп, поместите образец на основание или держатель предметного 
стекла, отрегулируйте расстояние до объекта и фокусное расстояние. 
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 Когда микроскоп подключен к внешним устройствам, данные изображения передаются 
на внешнее устройство, поэтому на мониторе микроскопа не отображается изображение. 

 Выход HDMI поддерживает фотосъемку, но не запись видео. 

16.2 USB 

Установка программного обеспечения 
Вы можете скачать программное обеспечение со страницы- bit.ly/3xCRDPL. В настоящее время 

программное обеспечение «Microscope Measure» поддерживает только систему Windows. 
 Система требует:Windows XP SP3, Windows 7, Windows 8, Windows 10 

 Время выполнения：Microsoft.Net Framework 4.0 
   Microsoft Visual C++ 2010 

Если система не подходит под требования, в процессе установки будет сообщено об ошибке. 
После завершения загрузки откройте zip file и запустите его. 

Обозначение иконок  

 

Увеличение 

 

Измерение угла в 3 точках (градус) 
Вернуться к исходному масштабу Расстояние между паралл. линиями 

(длина) 
Уменьшение Расст. от точки до линии (длина) 

Отмена последнего действия Расст. между 2 окруж-ми (радиус, длина) 

Перекрестие крестовина, 4 / 8 линий Расст. от линии до окруж. (радиус, 
длина) 

Горизонтальное расстояние, 2 точки Добавьте квадратную метку 

Вертикальное расстояние, 2 точки Добавьте круговую метку 
Диагональ, 2 точки Добавить текст 

Измерьте прямоугольник (ширину, высоту, 
окружность и площадь) 

Расстояние между 2 линиями (длина) 

Измерьте эллипс (радиус длинной оси, радиус 
короткой оси, окружность и площадь) 

окружность из 3 точек (радиус, 
окружность и площадь 

Измерьте радиус окружности (радиус, 
окружность и площадь) 

Обнаружение границ 

Измерьте диаметр окружности (диаметр, 
окружность и площадь) 

Увеличение/уменьшение яркости 

Измерьте окружность в 3 точках (радиус, 
измерьте дугу в 3 точках 

Переверните горизонтально 

Измерьте многоугольник (окружность и 
площадь) 

Резкость 

Измерьте многоугольник (окружность и 
площадь) 

Сглаживание 

Измерьте линии сгиба (длину) Фотография 

Измерьте угол в 4 точках (градус) Видео 
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17. Определения и функции интерфейса 

 
① Главное меню: 
В нем пользователи могут открывать различные устройства, импортировать изображения для 

просмотра или редактирования, выполнять настройки видео или сохранять настройки, выбирать, 
какие окна показывать или скрывать и т.д. 

②Панель инструментов: 
На ней отображаются инструменты, используемые для проведения измерений и анализа 

изображений. Определение и назначение различных инструментов приведено в разделе 
"Определения значков". Скрыть или показать окно панели инструментов можно по следующему пути: 
"Вид→Панели инструментов и стыковочные окна→Стандартные". 

③Обозреватель картинок: 
Здесь пользователи просматривают все сделанные ими фотографии. Пользователи также могут 

редактировать изображение, щелкнув правой кнопкой мыши на нем и открыв его в главном рабочем 
окне. Чтобы показать или скрыть это окно, выберите "View→Toolbars and Docking Windows→Picture 
browser". 

④ Второстепенное рабочее окно: 
Это окно предназначено для цифрового увеличения области вокруг курсора. С помощью этого 

окна можно гораздо точнее определить результат измерения. 
⑤ Главное рабочее окно: 
В этом окне отображается полный вид микроскопа. В этом окне также выполняются измерения 

и анализ изображений. 
⑥Управление калибровкой и результаты измерений: 
Эти два окна отображаются в одном и том же месте, пользователи могут переключать их, 

нажимая кнопку. 
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18. Этапы работы 

Состав: Компьютер (система Windows, с программным обеспечением «Microscope Measure»); 
USB-микроскоп (название устройства: «USB CAMERA»), линейка. 

Шаги: 
1. Подключите микроскоп к компьютеру с помощью прилагаемого USB-кабеля. После того, 

как на мониторе микроскопа отобразится несколько вариантов, выберите «USB-камера», нажав 
кнопку «вниз» и «ОК» или с помощью пульта дистанционного управления.  

2. Откройте программное обеспечение «Microscope Measure». 
Нажмите "File»→ «Открыть»→ «Открыть устройство»→ «РЕЖИМ USB» → «КАМЕРА USB». 

 

Управление калибровкой Результаты измерения 

- Показывает список 
различных калибровок. 

Пользователь может 
выбрать, чтобы удалить 

или применить. 

Новые калибраторы 
(подробности будут 

приведены в др. главе) 

Показывает размер. 
Можно изменить в «file 

– Videosetting – video 
capture pin – (S) 

Показывает результаты 
всех измерений 
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19. Функции 

1. Калибровка 
1. Поместите линейку под цифровой микроскоп, 

отрегулируйте фокусирующую трубку и высоту подставки, чтобы 
получить наилучшее разрешение и желаемое увеличение. 
(После того, как это сделано, держите расстояние до объекта 
для остальных шагов) 

2. В «Управлении калибровкой» задайте имя и единицу 
длины новой калибровки (см. рисунок справа). Затем нажмите 

«Калибровка», тем временем на панели инструментов 
должен был быть выбран автоматически. Если нет, пожалуйста, 
выберите его сами. 

3. Подведите курсор к основному рабочему окну, 
начертите с помощью линейки линию единичной длины (не 
имеет значения, если результат длины будет отображаться 
иначе). После этого нажмите кнопку «Готово» в нижней части 
окна «Управление калибровкой». 

4. Проверка. Длина линии, которую вы нарисовали на 
шаге 3, теперь должна отображаться как единица длины. 
Название новой калибровки должно было появиться в списке 
калибровок. 
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2. Измерение 
1. Выберите инструмент, который вам нужен для измерения на панели инструментов. 
2. Щелкните точки или нарисуйте линии, которые необходимо измерить, в главном рабочем 

окне.  
3. Поместите результаты измерения в нужное место вокруг цели. 
3. Особенный эффект (спецэффект) 
Включает: Обнаружение краев, Обратный цвет, Отразить по горизонтали, Рельеф, Резкость и 

Сглаживание. 
Шаги: 
1. Выберите нужный вам спецэффект на панели инструментов. 
2. Переместите курсор в главное рабочее окно, щелкните левой кнопкой мыши и удерживайте, 

чтобы нарисовать прямоугольник, покрывающий всю целевую область, отпустите кнопку мыши, чтобы 
получить результат специального эффекта. 

3. Щелкните левой кнопкой мыши еще раз, чтобы закончить спецэффект.  
Примечание: В отличие от других спецэффектов, «Отразить по горизонтали» будет применяться 

ко всему окну вместо целевого прямоугольника. 
4. Захват и запись 

1. Нажмите '  захватить. 
2. Результат захвата можно просмотреть и удалить в окне 'Picture browser'. 
3. Проверьте и измените путь сохранения: “File→Save Setting→Path”. 
Запись 
1. Выберите разрешение видео 640 * 480 по пути «File→Video Setting→Video Capture 

Pin→Output size(S)” 

2. Нажмите завершите другие настройки и начните запись 

3. После начала записи в левом верхнем углу появится таймер. 
4. Проверьте и измените путь сохранения: " File→Save Setting→Path". 


